What's New

Sage UBS version 9.9.4.9

Release Date:
19t December 2019

V9.9.4.9 Updates

The following enhancements are being released:

Email function

e Standard message maintenance
e  Customer/ Debtors file maintenance
e  Official receipt
e Credit Note & Debit note
MY SST

e Taxreport by tariff code
e SST-02A
e Laporan CJ(P) Jadual C-01
O SST supporting documents
e MY-DST
O Digital service tax

SG GST

e Overseas Vendor Registration
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Email function

Sage UBS

In the effort of going green and improving user experience, email function for official receipt, credit note, and debit note is now
made available to users.

Standard message maintenance

Applicable for:
1. Official Receipt

2. Credit Note
3. Debit Note

Steps:

- General > Miscellaneous File > E. Email Maintenance (Accounting)

- Maintenance > Miscellaneous File > M. Email Maintenance (I&B)

0.File = 1.General 2 Debters 3. Creditors 4 Transactions 5. Reports 6. Periodic 7. Housekeeping 8. Toolkits 9.

1. General Ledger A/C Maintenance

2. Enter Opening Balances
3. Print Chart of Accounts

4, Fixed Assets Description Maintenance
5. Enter Last Year Figure
6. Maintain Stock Values
1. Maintain Project Titles

|at@st

8. Enter Project-Job Opening Balance

9. Foreign Currency ]

A. Miscellaneous Files

) I8 I(E

Creditors

Y&
4

Q New

Transaction
Debtor
Creditor

General Ledger Account

ﬁ Search

1. Business Maintenance

2. Region Maintenance

3. Area Maintenance

4, Agent Maintenance

5. Customer Site Maintenance
&. Supplier Site Maintenance

7. Tax Code Maintenance

8. Bank Code Maintenance

9. Bank Account Maintenance

A, Service Provider's Bank Code Maintenance
E. Payee Maintenance

. Service Provider's Payee Maintenance

D. Service Provider's Country Maintenance

E. Email Maintenance
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<3

To create a new template, simply choose a printout from dropdown list click on ‘New' and give a title to your message and edit it in

the field below and ‘Save' it.

Select message to edit Choose default message

Sample_Template

Sage_GlobalTemplate A~ Printout: [ Sales Credit Note

]

Default: [ Sage_GlobalT emplate ‘

| Deete |

. New | Zee | Rename |

Edit message:

Thank you.

This document is sent for your record.

Mery Christmas & A Happy New Year

Changes can be viewed in email window

To | ]
Subject | Credit Note #CNO00002 from S age Software Sdn. Bhd. A
(formerly known as UBS Corporation Sdn. Bhd.)
W
Message g ample_Template
This document is sent for your record. A
Thank you.
Merry Christmas & A Happy New Year
L
Send E =it
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Customer/ Debtor’s File maintenance (Accounting and 1&B)

Sage UBS

Customer/debtor's email addresses can be added in Customer File Maintenance / Debtors File Maintenance beforehand to ease
emailing processes. Email address will appear in email window.

Steps (Customer File Maintenance):

- Maintenance > Customer Maintenance > Customer File Maintenance

Fill in customer’s email in Email Address field and click Save and Exit.

Custorner Mo.

Mame

52 Customer Maintenance - Customer File Maintenance

3000/CHNL
CN COMFPRNY

Open ltem Custamer
] Bad Status

Addressl
Lddress2
Address3

Malaysia

Tems 30
Credit Limit

Target

Ireenice Limit

0.00
0.00
0.00

Group To 3000/CH1
Created Date 09/10/2019 09:58:29 RM

Enter thiz for foreign currency

Currency Cade

7

[ 4

Company Fegistration Mo.  |CRN 123456
Details  More Info Tawes
Invaice / Delivery Ta Lddressl
Lddress2
Address3
Malaysia
Attertion
I Email &ddress sagetest. 999@gmail. com
Weh Site hCtp: //WWW.CO-COMpany . Com
Phone No. (1) 03-22771234
Phone No. (2) 03-22771235
FandTelex 03-22711236
Contact 012-2277222
Business 7 Dizcount % Categary
Region ) () Category &
ategory
Cat B
Area #1 (D Category C
Agent £ ® Mone

Currency Symbal

Currency Ward

Add Save

BM
RINGGIT MRALAYSIL

Delete Exit
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Official Receipt (Accounting)

Steps:
- Debtors > Print receipt

- Debtors > Open Item Menu Debtor > Print receipt

- Transaction > Transaction File Maintenance

<O Transactions File Maintenance
BatchTile  |BANK - gur'zols | Correct TFM entiy methods ~ 28/11/2019
Batch No. s7|E] 2|
Voucher Seq. 57
Period 7|88
July 2019 A COMPANY
Date AJC No. Ref. No. Desp. Debit Credit
|28/07/2019]3000/A01 |[Z1JoR 00001 |BANK - UMBC A/C [2] 0.00] 100.00
|~
Bl Type | B
Bill Age [11]
Direct Input/Output T ax o
Payment For & COMPANY GST Cl 1 _
'VAT-CODE-AO1
Cheque No. |

Date A/C No. Ref. No. AJC Description Debit Credit A

28/07/201%]3010/000 OR 00001 |BANK - UMBC A/C 100.00 0.00

2 CoMPANY

v

Eres Pecs vea

L 8a [ @ > [ e8| P gk | ad | gk | P | Sme Lol | Ea

Print > Check period > OK > Email

Print Receipt

(®) Fomat 4 (8511 in)
() Format B [8.5%5.5in)

Period l:l July

Receipt No. From CR 00001 [#]
Receipt No. To CR 00001 [A]

oK || Cencel

<5
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Credit Note & Debit Note (1&B)

You can access the email function from 2 different menus, Transaction (Single email form) and Print Bills (By batch).

Steps (Single email form):

- Transactions > Credit Note > Credit Note (Adjustment/ Sales Return) > Print > Email

S Add Credit Note (Adjustments [=]
Credit Note - Adjustments Last CN No. CNO00002
Period 10, October-2019
Credit Note No. CNO00002
Cust. No. 3000/G01 || 2 Update from Invoice
Name COMPANY A
Dt C
ate 31/10/2019 Sendto ...
Ref. No. 2
Description DISCOUNT % :
PO/S0 No. Print ... Preview Select Printer Email
PO/S0 No. (2] Convertor -5 Test file Excel ...
DO No. (1) . 5
Setting Customize Cancel
DO No. (2)
Remark 0
Remark 1 Remark 9
Remark 2 Remark 10
Remark 3 Remark 11
W a e T p Add Body Eat
Steps (By Batch):
- Print Bills > Credit Note/ Debit Note/ Invoice > Verify Period > OK > Email
<5 Email [mESm]
Customer Listing To:
COMPANY A ~ | All cheryl leong@sage. com v
Debtor No.  Selected ~ Sibject
Multiple Debit Notes from Sage Software Sdn. Bhd. [formerly known as IUBS Corporation Sdn.
30004002 0
Message:
TestDNTemplate D‘s

Invalid Email address

5age_Globall emplate g with debit notes transactions e-mail template. A
TestDNTemplate2

This message sentences is for testing purpose only.

v

Send

Record Listing Email Status | All ~
{ [} Doc. No. Date Customer Amount [RM) Status

[] | oooooooi 2019110/08 | COMPANY A £95393.04| Emailed A

[J | ooooooo2 2019/10/08 | COMPANY A 38057351 Emailed

[] | ooooooo3 2019/10/08 | COMPANY A 977566.50/  Emailed

[] | ooooooo4 201910/08 | COMPANY A 3437201 Emailed

[] | ooooooos 201910/08 | COMPANY A 908.30| Emailed

[] |ooooooo7 201910/08 | COMPANY A 163291|  Emailed

[] |ooooooog 201911010  |COMPANY A 105.00)  Emailed

[] | ooooooog 201971011 | COMPANY A 331575 Emailed

[7] | ooooooo 2019/10/11  |COMPANY & 7127.40)  Emailed v

Exit

Sage UBS
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MY SST

Tax report by tariff code

«7

In this enhancement, users and SST registered companies are now able to view tax report grouped by tariff code so that users can

reconcile amount shown in SST-02 report, Section B1.

Applicable for:

1. Sales Tax report
2. Service Tax report

3. Service Tax report

(Receipt based)

a. Group by Tariff code

Steps:

- Reports > Goods And Service Tax > Malaysia SST > Sales Tax Report

Check the Tariff Code checkbox

-

s G

Sales Tax Report

=]

Include tax code without tax method 7 [

Group By :
Drate Fram 0l/10/201%9 e
Date Ta 04/10/201%9
Tranzaction Type .
Tax Code s

T ariff Code

LCancel

TRANSACTIONTYPE : ALL

SALES TAX REPORT

DATE RANGE : 01/10/2019 TO 04/10/2019

PRINTED ON: 01/11/2019

Demo Company PAGE: 1
PD DATE ACCNO  REF. COMPANY Tax%  Tmable Sales  Taxable Purch  Tax Collscted Tax Paid
9901.01.0650 Accommodation

ST05 Sales Tax 5%

10 01/10/2019 5000/000  INO00OOL A COMPANY 5.00 1,000.00 0.00 50.00 0.00

10 01/10/2019 5000/000 NV 0001 A COMPANY 5.00 1,000.00 0.00 50.00 0.00
Total for STOS Sales Tax 5% 2,000.00 0.00 100.00 0.00
ST10 Sales Tax 10%

10 02102019 5000/000 IN000O02 A COMPANY 10.00 1,000.00 0.00 100.00 0.00

10 02102019 5000/000 NV 0002 A COMPANY 10.00 1,000.00 0.00 100.00 0.00
Total for ST10 Sales Tax 10% 2,000.00 0.00 200.00 0.00
STDO2 Sales Tax Deduction — 2%

10 03/102019 6010/000 SINV 0001 X COMPANY 5.00 0.00 1,000.00 0.00 50.00
Total for STD0? Sales Tax Deduction — 2% 0.00 1,000.00 0.00 50.00
Total for 9901010650 Accommodation 4,000.00 1,000.00 300.00 50.00
9902.01.2651 Food and Beverages
OUS0 Value of Goods for Own Used / Disposed 0%

10 03/10:2019 5000/000 INO00OO3 B COMPANY 0.00 1,000.00 0.00 0.00 0.00

10 03/10/2019 5000/000 NV 0003 B COMPANY 0.00 1,000.00 0.00 0.00 0.00
Total for OUSQ Value of Goods for Own Used / Disposed 0% 2,000.00 0.00 0.00 0.00
oUss Value of Goods for Own Used / Disposed 5%

10 04/10:2019 5000/000 IN0O0OO4 B COMPANY 5.00 1,000.00 0.00 50.00 0.00

10 04102019 5000/000 NV 0004 B COMPANY 5.00 1,000.00 0.00 50.00 0.00
Total for OUSDS Value of Goods for Own Used / Disposed 5% 2,000.00 0.00 100.00 0.00
Total for 9902.01.2651 Food and Beverages 4,000.00 0.00 100.00 0.00

Grand Total: 8,000.00 1,000.00 400.00 50.00
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b. SST-02 report under section B1 group by tariff code

—

< Malaysia SST Return

SS8T-02 (Sales)

Sales Tax Reg. No.:  |SALT 0001
File T axes From: 01/10/2019 | To |04/10/2019

Note:
+ Transaction with tax code without tax method will not be shown in this report.
* For service tax submission, knock-off is required and system will refer to document date on invoice or

receipt, whichever comes later, as the reporting date for SST-02 submission.

LCancel

"B_ack

Part B1: Sales / Service Details

6. Description of Taxable 5 8. Value of Taxable Goods Sold 9_Value of Goods For .
: 7. Customs Tariff Code / Service i i o 3 £ & 0. Value of Taxable Service
Goods / Type of Taxable {Including Value of Debit Mote) / Own Used / Disposed Values of 4 E
il - Type Code _ : 3 (Including Value of Debit Nate) (RM)
Service Provided / Imported. Value of Work Performed (RM) Free Services (RM)
1 Accommodation 9901.01.0650 4,000.00
Z Food and Beverages 9902.01.2651 4,000.00
Total 4,000.00 4,000.00

Net Total 8,000.00
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SST-02A

With this enhancement, businesses that are not registered with SST will utilize this feature, SST-02A for reporting imported service

tax.

a. Add more info in Accounting and I1&B

Users will have more fields to enter other company information. Other than company name, address, registration no., users can

enter postcode, phone no., email address etc.

Steps:
- Housekeeping > Setup > General Setup

Click on Full Info
2 General Setup
Company Profile

Company Name
Address

Company Type

Company Registration No.
Company UEN

Major Industry Code

as this information will be included in SST-02A report.

Setting Setting 2 Malaysia Taxes

Sage Software Sdn. Bhd. (formerly known as UBS Corporation Sdn. Bhd.)
Suite 1B-€, Level &, Block 1B,

Plaza Sentral, Jalan Stesen Sentral S,

Kuala Lumpur Sentral,

50470 Kuala Lumpur.

441335-K

Add |:| With Malaysia GST

Debtor Account Groups

Last Accounting Year

From 3000 Closing Date Anziz2ms
To 3000 Starting Period 7

Closing Period
Creditor Account Groups osng e 12
From 1000 This Accounting Year

T

To 1000 01/01/2019 0 [31/12/201%

Last Accounting Year

y
/ _/ To /7
0K LCancel
Fill in necessary fields
p
<2 More Information e

Company Name

Addiess

City/Town
Postcode
Phone No.
Email

Company Registration No.

Sage Software Sdn. Bhd. (formerly known as UBS Corporati
Suite 1B-&, Level €, Block 1B,

Plaza Sentral, Jalan Stesen Sentral 5,

Kuala Lumpur Sentral,

50470 Kuala Lumpur.

State Please Select ~

Fax Mo.

4413

=]
w

-K
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b. Add New Tax Code and Tax Method

A new tax code and tax method is now available to map for SST-02A, so transactions entered in the system with tax code with tax
method assigned will be shown in SST-02A report.

Steps:
- General > Miscellaneous Files > Tax Code Maintenance

New Tax code: NRIS

<O Tax Code Maintenance ===
Tax Code Maintenance
Tax Code Desoiiplion TaxPetcentage Transaction Type  Tax Method A/CNo Status SST ~
IM Import of goods with GST incurred. (By referring Custon €.00|P IMP (OBSOLETE
IM-CG Import of goods with GST incurred for a capital goods 4 €.00|P CGD [ACTIVE
| |IM-RE Import of goods with GST incurred that is not directly €.00[p PEX OBSOLETE
1S Imports of goods under Approved Trader Scheme (ATS) whe 0.00|p NIS ACTIVE
NE Matters to be treated as neither a purchase of goods ng 0.00[P (OBSOLETE
MR Purchase from non GST-registered supplier with no GST i 0.00|P (OBSOLETE
MRIS Imported Service for Non-Registered Company €.00[s SST-02A-10a ACTIVE SERVICE
NS Matters to be treated as neither a supply of goods nor 0.00[s OBSOLETE
[NTX Supplies with no tax chargeable. 0.00|s 0s (ACTIVE
oP Purchase transactions which is out of the scope of GST 0.00|P [OBSOLETE
05 out-of-scope supplies under GST legislations. 0.00[s 0s ACTIVE
0S-ER Out-cf-scope supplies for Enforcement and Regulatory £y 0.00[s OBSOLETE v
Add Edit Delete Print... Seve Cencel Regenerale Malaysia Tax Codes Exit
c. Generate SST-02A report
Users can now generate SST-02A report which is similar to SST-02.
Steps:
- Reports > Goods And Service Tax > Malaysia SST > SST Return
Select SST-02A option
- -
<2 Malaysia SST Return =
|

Sales and Service Tax Return

Pleasze select your submission type:

(O | would like to report sales tax in $ST-02.
| would like to report service tax in SST-02.

| would like to report SST-024,

Note:

& Transaction with tax code without tax method will not be shown in this report.

& For service tax submission, knock-off is required and system will refer ta document date on invoice or
receipt, whichever comes later, as the reporting date for SST-02 submission.

Next LCancel
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Enter SST-02A number and fill in date range

- =

< Malaysia SST Return

SST-02A

SST-024 No.: NR-0001-123454
File T axes From: 01/01/201% | To |01/10/2020

Note:

+ Transaction with tax code without taz method will not be shown in this report.

* For service tax submission, knock-off is required and system will refer to document date on invoice or
receipt, whichever comes later, as the reporting date for S5T-02 submission.

Back Cancel

You will be directed to the SST-02A web Ul, fill or edit any mandatory fields. Then, generate pdf.

Regulatory Reporting

SST-02A

Data import has been successful.

No. SST-02A: Amendment
Part A: Details Of Person Other Than Registered Person Particulars
1 Business Registration No~ 441389-K
OR
2 Identity Card No™
3 | Nameof Business’ Sage Software Sdn. Bhd. (formerly known as UBS Corporation Sdn. Bhd.)
4 | Business Address” Suite 186, Level 6, Block 18, Plaza Sentral, Jalan Stesen Sentral 5,
Kuala Lumpur Sentral, 50470 Kuala Lumpur.
Town™
Postcode” 50470 State” WP Kuala Lumpur v
5 | TelephoneNo:
6 FaxNor
7 Email Address”
8 Transaction Type” v Imported Services
Others
If "others’, please specify:
Part B: Service Details
9 Period of Declaration From Until
10 Total Value of Payable as per Tax Rate
z:r‘:fc‘:;;:agzm ” TaxRate Value of Tax Payable
a  Value Of Imported Services 3,000.00 180,00
b Others 0.00 000
11 Total Value of Tax Payable. 18000
12 Penalty Rate/Penalty Amount 000
13 Total of Tax Payzble 18000
Part C: Declarations
14 lastheauthorized personunder Section 74 or 75 of the Service Tax Act 2018 hereby certify that the particulars stated in this return are true and complete.
Date 03/12/2019

15 Name of Declarant
16 Identity Card / Passport No.
17 Designation of Declarant

18 Telephone No.

Preview PDF Generate PDF
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Important Note:

Only General Journal transaction will be captured and show in SST-02A. Any transaction with type Invoice, Debit Note, Credit
Note, Payment, Return Cheque, and Cash Sales are NOT showing in this report. In local tax report, as there is no offset needed,
you can only check result in the standard Service Tax Report.

Sample transaction as below:

Transaction In UBS | Tax Account Is Direct Debit | Credit Taxable SST-02A Report
(Accounting) Code Input/Output Amount 104

Reference No. Taxable  Tax
Service Payable

GJ-001 NRIS Tax Payable Yes 60.00 | -1,000.00 | 1,000.00 60.00

Expense 60.00
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Laporan CJ(P) Jadual C-01

«13

This is an SST supporting document. This report tracks discrepancies between movement of items (import/export) and productions
operations and items that are tax exempted. This feature is only available in Inventory & Billing.

Steps:

- Reports > Goods and Service Tax > Malaysia SST > Laporan CJ(P) Jadual C-01

Enter date and Generate.

Excel file will be generated and downloaded to PC.

WO W R

6
]
]

<> Laporan CJ (P) Jadual C-01

Laporan CJ(P) Jadual C-01

Note:
* Transaction with tax code without tax method will not be shown in this report

+ For service tax submission, knock-off is required and system will refer to document date on invoice or
receipt, whichever comes later, as the reporting date for S5T-02 submission

File Taxes From

01/01/2019 To |(31/07/2

i _Generate Cancel

019

A B

D E

H

K L M N 0] P Q

LAPORAN PEMBELIAN/ PENGIMPORTAN DAN PENGGUNAAN BARANG-BARANG YANG DIBERI PENGECUALIAN CUKAI DI BAWAH
BUTIRAN 1, 2, 3 & 4, JADUAL C, PERINTAH CUKAI JUALAN (ORANG YANG DIKECUALIKAN DARIPADA PEMBAYARAN CUKAI) 2018

Nama Syarikat ABC Sdn Bhd Alamat Syarikat Suite 18-6, Level 6, Block 1B, Plaza Sentral
Butiran P ian - MyExemptDetail Jalan Stesen Sentral 5. 50470, Kuala Lumpur
No. Sijil Per 12 MD0-1234-12340000
Tarikh Sijil : 03 Sepitember 2019
Bil. Perihal Barang Nama Stok Permulaan Pembelian Tempatan Pengimportan Di dalam Dil Baki Akhir Catatha
pada 01/09/2019 F i Dijuall Dig Pada n C3/ Caf
Secara Lain 3010972019 Jika
Kuantiti| Nilai Tarikh/ Kuantiti Nilai Tarikh/ No. Invois/ No. K1 Kuanfitii  Nilai  |Kuanfiti Nilai |anq  Nilai Kuantiti Nilai m
(RM} | Mo. Invois | Delivery (RM) (RM) RM) (RM] (RM) ELTE
Order Butiran
34
Jadual C|
1| Mini Foam 200| 2578.00
2 Mini Foam AAA Sdn. Bhd 05/092019 / PIN-001 100 1289.00
3| Mini Foam CDE Sdn. Bhd 07/0%2019 /678976 300 3738.00
4| Mini Foam AAA Sdn. Bhd 15092019/ PIN-25 250 322250
5| Mini Foam 505 6509.45) 300 3867.00| 45| 45055
6| Medium Foam '] 0.00
7| Medium Foam AAA Sdn. Bhd 05092019/ PIN-001 15[ 2875.00
8| Medium Foam AAA Sdn. Bhd 15092019/ PIN-25 330 8250.00
9| Medium Foam 445|  11125.00| 1] 0.00
10| Large Foam [] 0.00
11| Large Foam CDE Sdn. Bhd 07/09%2019 /678976 240 7200.00
12| Large Foam Thai Co. Ltd 0770972019 / THOS18 / 724522325 1120] 3360000 c3
13|Large Foam 1360( 40800.00 [] 0.00
JUMLAH 200| 2578.00 1335) 2657450 1120) 3360000 2310 5843445 300 3667.00 45| 450355
* Saya akui butir-butir makiumat yang dinyatsksn dalam lsporan ini sdslsh betul dan benar.
Tandatangan
Nama penuh
Jawatan

Cop Syarikat
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MY - DST
- Digital service tax

a. DST - Add country selection in tax code maintenance

Pre-requisite:
- With International License

Sage UBS

- Administrative Tools > Imported Taxable Services setting is ON (Accounting is on Setting 3, while Inventory & Billing is on Setting 2)

=3 Administrative Tools

el

Setting Setting 2 Tools E-Banking
Trans. Limit [Cremal so0 | (500]
Date Expired 12/12/3069 | [12/12/3083)
Transaction of Batch No. ta remaove 0 Apply
Tax Code Setting Tax Setting
Default Tax Code for Sales Tax SE ] I Imparted Taxable Services
Default Tax Code for PurchazeT ax TX A
Bozz Menu Allowed Pin a
Ok Cancel
Steps (Accounting):
General > Miscellaneous Files > Tax Code Maintenance
Inventory & Billing:
Maintenance > Miscellaneous Files > Tax Code Maintenance
< Tax Code Maintenance @
Tax Code Maintenance
Country | Singapore v Tax Type  {EH ~
[ GST
Tax Code Description Tax Percentage Transaction Type Tax Method A/CNo Status SST Country A
BL Purchases with GST incurred but not claimable under Red 7.00|P ACTIVE SG
DS Deemed supplies 7.00|S SRS ACTIVE SG
EP Purchases exempted from GST 0.00|P EXP ACTIVE SG
ES33 Regulation 33 Exempt supplies 0.00|S EXS ACTIVE SG
ESN33 Non Regulation 33 Exempt supplies 0.00|S EXS ACTIVE SG
IGDS Imports where the GST is suspended until the filing daf 7.00|P SRP ACTIVE SG
M GST incurred for import of goods 7.00|P IMP ACTIVE SG
ME Imports under special scheme with no GST incurred 0.00|P MES ACTIVE SG
NR Purchase from non GST-registered supplier with no GST j 0.00|P ACTIVE SG
oP Purchase transactions which is out of the scope of GST 0.00|P ACTIVE 56
05 Out-of-scope supplies 0.00[s ACTIVE 5G
PM Payment Made 0.00|B PRY ACTIVE SG v
Add Edit Delete Print... Save Caricel Exit

If you are oversea country (not Malaysia) company and would like to report MY DST, here is the proposed tax code.

Tax Code | Description

SST

Country

SVDST Service Tax for Digital Services | 6%

Sales

‘ Tax % ‘ Transaction Type  Tax Method  Status

ACTIVE

MY
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b. Other Taxes
Pre-requisite:
- With International License

- Imported Taxable Services setting is ON
Steps (Accounting):

- Housekeeping > Setup > General Setup > Other Taxes

- Verify Other Taxes tab when the Imported Taxable Services setting is ON

'Malaysia Taxes tab disabled if the selected country in landing page is Singapore and other countries

“%2 General Setup @
Company Profile Setting Setting 2 I I Other Taxes
Company Hame |Demc: Company
Address Suite 1B-6, Level &, Block 1B,

Plaza Sentral, Jalan Stesen Sentral 5,

Kuala Lumpur Sentral,

50470 Kuala Lumpur. Full Info

Company Type
Company Registration Mo, 441389-K
Company UEM
G5T Registration MHo. GSTO001
Debtor Account Groups Last Accounting ‘rear
From 3000 Closing Date FAzezma
i s Starting Period 1

Cloging Period 2
Creditor Account Groups 9 L
From 4000 This Accounting vear

T = 01/01/201% | To |31/12/201%9
o 4000

Last Accounting ear

G5 i To G5 i

Ok LCancel

Imported Taxable Services setting is ON, 'Other Taxes tab enabled if the Imported Taxable Services setting is ON

<% General Setup
Compary Profile Setting Setting 2

Country Tax Reference -~

M Singapore Sg1122334455667 7289300
Malaysia b1 2345678390
Thailand Thi2345673303876543210

L v

Courntry

Singapore p

Tax Reference |59112233445566778395900

Add Edit Delete Save Cancel

LCancel
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SG SST

Overseas Vendor Registration

a. OVR - Add country selection in tax code maintenance

Sage UBS

In this enhancement, the country selection is available in Tax Code Maintenance when Imported Taxable Services setting is ON, tax
code can be grouped and viewed by country for those who are applying cross country taxes.

Pre-requisite:
- With International License

- Housekeeping > Administrative Tools > Imported Taxable Services setting is ON

Steps (Accounting):
- General > Miscellaneous Files > Tax Code Maintenance

- Verify country and tax type when the selected country in landing page is MALAYSIA

| Select Country i |
CL AED English ~

Compary Mame Sage Software Sdn. Bhd. (formerly known as UBS Corporat:
Compary Registration M | 441388-K GST Registration Mo,
Address Suite 1B-6, Level &, Block 1B, [ &dvance Setting

Plaza Sentral, Jalan Stesen Sentral 5,

Kuala Lumpur Sentral,

50470 EKuala Lumpur.
Tax % 0.00
Lebelonthlare M5 Sans Serif 'T Account No. Format
TextBox FontMame Courisr New Fa
Roines (®) wmnd s

() et
GST G5T
Sales Tax Sales Tax Date System
Purchase Tax Purchase Tax O American () China / Japan
Batch Title Description ® Briish O Taiwan
gt SALES Debtor Account Groups From 3000
Batchis PURCHRSE Debtar Account Groups To 3000
Batch 3 BANE Creditor Account Groups From 4000
Batch 4 CRSH Creditor Account Groups To 4000
Batch & JOURNLL
Standard Repot Dir. | £2\ URSACC2015\REFORTS\REPORTS_TIMES NEW_ROMANY
Report Canvertar Dt | £+ URSACC2015\ REFORTS '\ CONVERTORY,
Set to Default

Qg LCancel

Check Tax Setting, Imported Taxable Services

2 Administrative Tools
Setting Setting 2

Tranz. Limit [D'ema) soo | (500)

Tranzaction of Batch Mo, ta remaove i}

Date Expired l2/12/306% | [12/12/3069)

Toaols

Tax Code Setting Tax Setting

Default Tax Code for Sales Tax SE

= I Imported Taxable Services I

Default Tax Code for PurchaszeT ax TX F

Boss Menu Allowed Fin i

)

E-Banking

2pply

LCancel
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Steps (Inventory & Billing):
- Maintenance > Miscellaneous Files > Tax Code Maintenances
- Verify country and tax type when the selected country in landing page is Malaysia

- Check Tax Setting, Imported Taxable Services

- The default tax code will be SVDST if selected country is Malaysia, if it is SG you will have to create your own tax code (eg.

«17

SROVR)
<% Tax Code Maintenance (e
Tax Code Maintenance
Country | Malaysia v Tax Type  SST ~
Tax Code Description Tax Percentage  Transaction Type Tax Method cm A/CNo Status 58T Country A
ST-0 Sales Tax 0% 0.00|5 ACTIVE SALES MY
ST0S Sales Tax 5% 5.00|5 S55T-8,11A,13a ACTIVE SALES MY
ST10 Sales Tax 10% 10.00|S S55T-8,11B,13a ACTIVE SALES MY
STD02 Sales Tax Deduction - 2% 5.00|P 55T-13b,13A ACTIVE SALES MY
STD04 Sales Tax Deduction - 4% 10.00|P SST-13b,13A ACTIVE SALES MY
SvV-0 Service Tax 0% 0.00|5 ACTIVE SERVICE MY
SV0E Service Tax €% €.00|5 §5T-10,11C, 13 ACTIVE SERVICE MY
| MSVDST Service Tax for Digital Services €.00|S ACTIVE SERVICE MY
SVL Sales of Goods under Schedule 2, Sales Tax Order 2018 4§ 5.00|5 S5T-17iii ACTIVE SALES MY
v
Add Edit Delete Brint... Save Cancel Regenerate Malaysia Tax Codes Exit

If you are oversea country (not Singapore) company and would like to report SG OVR, here is the proposed tax code.

Tax Code Description Tax % Transaction Type  Tax Method  Status SST

/ Tax Type

SROVR Supply of digital services 7% Sales SRS ACTIVE | -
accountable by the electronic
marketplace under the
Overseas Vendor Registration
Regime

Country

SG




18> Sage UBS

b. OVR - Group Malaysia taxes under one setting and create new setting for other countries taxes

In this enhancement, the country selection is now available in Tax Code Maintenance when Imported Taxable Services setting is ON.
The tax code can be grouped and viewed by country for those who are applying cross country taxes.

Steps (Accounting):
- Housekeeping > Setup > General Setup > Malaysia Taxes
- Verify Malaysia Taxes tab when the selected country in landing page is Malaysia

- Check Tax Setting, Imported Taxable Services

Malaysia Taxes tab enabled if the selected country in landing page is Malaysia.

< Gene =]
Company Profile Setting Setting 2 | Other Taxes
55T GST GST 2
Sales Tax Reg Mo SalTax0001 55T Effective Date |01/11/201%
Service Tax Reg. Mo SerTax0001 55T Mext Filing Date |01/11/2019
55T Tauable Period / Categorny | 2 months ~ Taxable Period
T ariff Code Maintenance

Exempt Information

Exempt Detail / Description Exempt Detail
Exempt Certificate Mao. Exempt Cert. No.
Exempt Certificate D ate Q170172020

[u]8 LCancel
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Useful Fixes

No ‘ Case ID Brief Description

1 SAA1-581 Issue: [Preview — DN Print Bills] When preview custom report to cross check GST bills report format for E-
mail function, system shows RTE.

Resolve: Able to preview the report without prompt of any RTE issue
2 SAA1-354 Issue: Tax code follows default setting when update from DO to Invoice

Resolve: GST Classification is now displayed as SEC1 as expected.

3 SAA1-556 Issue: [Email — DN Print Bills] Subject titles by default showing “Multiple Invoices...."

Resolve: Now shows "Multiple Debit Notes from Sage Software Sdn. Bhd. (formerly known as UBS
Corporation Sdn. Bhd.)"

4 SAA1-560 Issue: [Email — DN Print Bills] When select checkbox any items that are not on 1st row, the blue
highlighted box will always jump back to the top row.

Resolve: The blue indicator highlighted box should always stay on the selected item.

5 SAA1-561 Issue: [Email — DN Print Bills] Prompt wrong message “No invoice. with...."

Resolve: Now shows "No Debit Note with valid Email selected from the record list. "

End



